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Note:  Our intent is that you try this problem on your own first.  After you have solved it on your
own, you can step through our solution if desired.  If you have problems trying to create the
model, then follow the steps in our solution.

Concrete Material Properties
E =5000 ksi, Poissons Ratio = 0.2
Member Properties
Column Girder

A = 40 ft2 A = 35 ft2

I = 400 ft3 I = 500 ft3

AS = 30 ft2 AS = 12 ft2

Moving Load
Number of Lanes = 2

Check for worst case of HS20-44 truck load and HS20-44L lane load applied
to each lane simultaneously.

Use the Exact method of calculation.

To Do
Set the number of ouput segments for girder elements to 2.  Review the moving 
load influence line for vertical displacement at joint A in Lane 1.  Review the 
moving load girder M33 moments in Lane 1.  Set the number of ouput 
segments for the girder elements to 10.  Review the same influence line and 
moments.

Problem R
Bridge With Moving Load
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Problem R Solution

1. Click the drop down box in the status bar to change the units to kip-ft.

2. From the File menu select New Model From Template…. This displays the Model
Templates dialog box.

3. In this dialog box click on the Portal Frame template                     button to display the
Portal Frame dialog box.

4. In this dialog box

• Type 1 in the Number of Stories edit box.

• Type 3 in the Number of Bays edit box.

• Type 70 in the Story Height edit box.

• Type 100 in the Bay Width edit box.

• Uncheck the Restraints check box.

• Click the OK  button.

5. Click the “X” in the top right-hand corner of the 3-D View window to close it.

6. Click the Set Elements button        on the main toolbar (or select Set Elements… from the
View menu) to display the Set Elements Dialog box.

7. In this dialog box:

• Check the Labels box in the Joints area.

• Check the Labels box in the Frames area.

• Click the OK  button.

8. Select column elements 1 and 4.  Press the delete key on the keyboard to delete these
elements.

9. Click the Refresh Window button         to refresh the drawing.

10. Select joints 2, 3, 5 and 8.

11. From the Assign menu select Joint and then Restraints... from the submenu to display the
Joint Restraints dialog box.
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12. In this dialog box:

• Verify that the Translation 1, 2 and 3 check boxes are checked.  If they are not checked,
check them.

• Click the OK button.

13. Select joint 5.

14. From the Edit menu select Move... to display the Move Selected Points menu.

15. In this dialog box:

• Type 20 in the Delta Z edit box.

• Verify that 0 is entered in the Delta X and Delta Y edit boxes.

• Click the OK button.

16. Select frame elements 5, 6 and 7.

17. From the Edit menu select Divide Frames... to
display the Divide Selected Frames dialog box.

18. Verify that the dialog box appears as shown in
the figure and click the OK button.

19. Select frame elements 8 through 13 (i.e., the
girder elements).

20. From the Assign menu select Frame and then Output Segments... from the submenu to
display the Frame Output Segments dialog box.

21. In this dialog box:

• Type 2 in the Number of Segments edit box.

• Click the OK button.

22. Click the Show Undeformed Shape button        to remove the displayed output segment
assignments so that you can see the frame element labels again.

23. Click the drop down box in the status bar to change the units to kip-in.

24. From the Define menu select Materials... to display the Define Materials dialog box.

25. Click on CONC in the Materials area to highlight (select) it, and then click the
Modify/Show Material button.  The Material Property Data dialog box is displayed.
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26. In this dialog box:

• Type 5000 in the Modulus of Elasticity edit box.

• Type .2 in the Poisson’s Ratio edit box, if it is not already entered.

• Click the OK button twice to exit all dialog boxes.

27. Click the drop down box in the status bar to change the units to kip-ft.

28. From the Define menu select Frame Sections... to display the Define Frame Sections
dialog box.

29. In the Click To area, click the drop-down box that says Add I/Wide Flange and then click
on the Add General item to display the Property Data dialog box.

30. In this dialog box:

• Type 40 in the Cross Sectional (Axial) Area edit box.

• Type 400 in the Moment Of Inertia About 3 Axis edit box.

• Type 30 in the Shear Area in 2 Direction edit box.

• Click the OK button to display the General Section dialog box.

• In this dialog box:

À Type COLUMN in the Section Name edit box.

À Select CONC from the Material drop-down box.

À Click the OK button to return to the Define Frame Sections dialog box.

31. In the Click To area, click the drop-down box that says Add General and then click on the
Add General item to display the Property Data dialog box.

32. In this dialog box:

• Type 35 in the Cross Sectional (Axial) Area edit box.

• Type 500 in the Moment Of Inertia About 3 Axis edit box.

• Type 12 in the Shear Area in 2 Direction edit box.

• Click the OK button to display the General Section dialog box.

• In this dialog box:
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À Type GIRDER in the Section Name edit box.

À Select CONC from the Material drop-down box.

À Click the OK button twice to exit all dialog boxes.

33. Select frame elements 8 through 13 (girders).

34. From the Assign menu select Frame and then Sections... from the submenu to display the
Define Frame Sections dialog box.

35. In this dialog box:

• Click on GIRDER in the Frame Sections area to highlight it.

• Click the OK button.

36. Select the two column elements.

37. From the Assign menu select Frame and then Sections... from the submenu to display the
Define Frame Sections dialog box.

38. In this dialog box:

• Click on COLUMN in the Frame Sections area to highlight it.

• Click the OK button.

39. Click the Show Undeformed Shape button        to remove the displayed frame section
assignments so that you can see the frame element labels again.

40. From the Define menu select Moving Load Cases and then select Lanes... to display the
Define Bridge Lanes dialog box.

41. In this dialog box:

• Click the Add New Lane button to display the Lane Data dialog box.

• In this dialog box:

À Accept the default Lane Name, LANE1.

À Type 8 in the Frame edit box.

À Type -6 in the Eccentricity edit box.

À Click the Add button.

À Type 9 in the Frame edit box.
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À Click the Add button.

À Type 10 in the Frame edit box.

À Click the Add button.

À Type 11 in the Frame edit box.

À Click the Add button.

À Type 12 in the Frame edit box.

À Click the Add button.

À Type 13 in the Frame edit box.

À Click the Add button.

À Click the OK button to return to the Define Bridge Lanes dialog box.  In this dialog
box:

• Click the Add New Lane button to display the Lane Data dialog box.

• In this dialog box:

À Accept the default Lane Name, LANE2.

À Type 8 in the Frame edit box.

À Type 6 in the Eccentricity edit box.

À Click the Add button.

À Type 9 in the Frame edit box.

À Click the Add button.

À Type 10 in the Frame edit box.

À Click the Add button.

À Type 11 in the Frame edit box.

À Click the Add button.

À Type 12 in the Frame edit box.

À Click the Add button.
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À Type 13 in the Frame edit box.

À Click the Add button.

À Click the OK button twice to exit all dialog boxes.

42. From the Define menu select Moving Load Cases and then select Vehicles... to display the
Define Vehicles dialog box.

43. In this dialog box:

• In the Click To area click the drop-down box and select Add Standard Vehicle to
display the Standard Vehicle Data dialog box.

• In this dialog box:

À In the Data Definition area select HSn-44 in the Vehicle Type drop-down box.

À Type 20 in the Scale Factor edit box if it is not already there.

À Click the OK button to return to the Define Vehicles dialog box.

• In the Click To area click the drop-down box and select Add Standard Vehicle to
display the Standard Vehicle Data dialog box.

• In this dialog box:

À In the Data Definition area select HSn-44L in the Vehicle Type drop-down box.

À Type 20 in the Scale Factor edit box if it is not already there.

À Click the OK button twice to exit all dialog boxes.

44. From the Define menu select Moving Load Cases and then select Vehicles Classes... to
display the Define Vehicle Classes dialog box.

45. In this dialog box:

• Click the Add New Class button to display the Vehicle Class Data dialog box.

• In this dialog box:

À Accept the default Vehicle Class Name, VECL1

À Verify that HSn441 is in the Vehicle Name drop-down box.

À Enter 1 in the Scale Factor edit box if it is not already there.

À Click the Add button.
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À Select HSn442 in the Vehicle Name drop-down box.

À Click the Add button.

À Click the OK button twice to exit all dialog boxes.

46. From the Define menu select Moving Load Cases and then select Bridge Responses... to
display the Bridge Response Request dialog box.

47. In this dialog box:

• In the Type of Results area check all four of the check boxes if they are not already
checked.

• In the Method of Calculation area select the Exact option.

• Click the OK button.

48. From the Define menu select Moving Load Cases and then select Moving Load Cases...
to display the Define Moving Load Cases dialog box.

49. In this dialog box:

• Click the Add New Load button to display the Moving Load Case Data dialog box.

• In this dialog box:

À Accept the default Moving Load Case Name, MOVE1.

À Click the Add New Assign button to display the Moving Load Case Assignment
Data dialog box.

À In this dialog box:

ä In the Assignment Lanes area click on LANE1 in the Select Lanes From list box
to highlight (select) it.

ä Hold down the Ctrl key on the keyboard and click on LANE2 to add it to the
selection.

ä Click the Add button to transfer these items to the Selected Lanes list box.

ä Click the OK button three times to exit all dialog boxes.

50. Note that the joint labeled A in the problem statement is labeled 10 on the screen.

51. Click the Set Elements button        on the main toolbar (or select Set Elements… from the
View menu) to display the Set Elements Dialog box.
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52. In this dialog box:

• Uncheck the Labels box in the Joints area.

• Uncheck the Labels box in the Frames area.

• Click the OK button.

53. From the Analyze menu select Set Options... to display the Analysis Options dialog box.

• In this dialog box click the Plane Frame XZ Plane button                    to set the
available degrees of freedom.

• Click the OK button.

54. Click the Run Analysis button       to run the analysis.

55. When the analysis is complete check the messages in the Analysis window (there should be
no warnings or errors) and then click the OK button to close the Analysis window.

56. From the Display menu select Show Influence Lines... and then Joints... to display the
Show Joint Influence Line dialog box.

57. In this dialog box:

• Select LANE1 from the Lane drop-down box if it is not already showing.

• Type 10 in the Joint ID edit box.

• In the Vector Type area select the Displacement option if it is not already selected.

• In the Component area select the U3 option (vertical displacement).

• Click the OK button to display the influence line.

Note:  This influence line is constructed with two output segments specified for the girder
elements.  Points for the influence line are calculated at the ends of each output
segment.  These points are then connected by straight lines.  You can clearly see the
segments in the influence line.

58. Click the Member Force Diagram For Frames button       to display the Member Force
Diagram For Frames dialog box.

59. In this dialog box:

• Select MOVE1 Moving Load from the Load drop-down box.

• In the Component area select the Moment 3-3 option.
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• Uncheck the Fill Diagram check box.

• Check the Show Values On Diagram check box.

• Click the OK button to display the moment diagram.

Note:  This moment diagram is constructed with two output segments specified for the
girder elements.  Points for the moment diagram are calculated at the ends of each
output segment.  These points are then connected by straight lines.  You can clearly see
the segments in the moment diagram.

60. Click the Lock/Unlock Model button        and click the resulting OK button to unlock the
model.

61. Select frame elements 8 through 13 (i.e., the girder elements).

62. From the Assign menu select Frame and then Output Segments... from the submenu to
display the Frame Output Segments dialog box.

63. In this dialog box:

• Type 10 in the Number of Segments edit box.

• Click the OK button.

64. Click the Show Undeformed Shape button        to remove the displayed output segment
assignments.

65. Click the Run Analysis button       to run the analysis.

66. When the analysis is complete check the messages in the Analysis window (there should be
no warnings or errors) and then click the OK button to close the Analysis window.

67. From the Display menu select Show Influence Lines... and then Joints... to display the
Show Joint Influence Line dialog box.

68. In this dialog box click the OK button to display the influence line.

Note:  This influence line is much sharper than the previous one.

69. Click the Member Force Diagram For Frames button       to display the Member Force
Diagram For Frames dialog box.

70. In this dialog box click the OK button to display the moment diagram.

Note:  This moment diagram is much sharper than the previous one.


